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Основной задачей рассматриваемого в данной книге программно-
го пакета под названием «Surfer» является расчет значений параметра 
в узлах регулярной сетки (Grid) по исходным данным в произвольных 
точках области. Данную задачу мы назовем интерполяцией, хотя с ма-
тематической точки зрения это не совсем корректное использование 
термина. Наиболее часто геологи сталкиваются с этой задачей при по-
строении карты поверхности пластов по данным бурения скважин. Ин-
терполяция – это главная, но далеко не единственная задача, которую 
можно решить с использованием Surfer, часть из которых попытаемся 
проиллюстрировать [1]. 

Почему Surfer. Существует большое количество программ, ре-
шающих подобные задачи. Сравнение этих программ с пакетом Surfer 
не входит в задачи данного пособия. Программа Surfer достаточно рас-
пространена, относительно дешева, проста в освоении и у нас есть опыт 
ее использования. Исторически сложилось так, что эта программа полу-
чила широкое распространение и по сути стала стандартом программ 
подобного типа, о чем говорит включение формата файлов Surfer в 
программы других производителей. 

Surfer разработала в 1983 г. небольшая американская фирма 
Golden Software, названная так по имени города Голден (Golden) в шта-
те Колорадо, где она находится. Фирма специализируется на разработке 
пакетов научной графики. 

Некоторые соглашения. Поскольку интерфейс программы (ме-
ню, помощь и описание) составлены на английском языке и многие 
термины не имеют точных аналогов в русском языке, а в русскоязычной 
литературе существует масса различных транскрипций одного и того же 
термина (например, встречаются такие варианты написания слова 
Kriging: Крайгинг, Кригинг, Крикинк и т. д.), мы будем пытаться при-
держиваться их английского написания и использовать только один 
из вариантов его русского произношения. Описание ведется примени-
тельно к 8-й версии программы Surfer8, далее просто Surfer. 

На кого рассчитано это пособие. Оно рассчитано в основном на 
начинающих пользователей пакета, возможно, люди, знакомые с про-
граммой, смогут найти что-то полезное и для себя. 
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Запуск программы. Если программа уже установлена, нужно вы-
брать в меню ПУСК> ПРОГРАММЫ>Golden Software Surfer 8> Surfer 8 
и подождать когда откроется рабочее окно программы. На этом приме-
ре договоримся, что с помощью знака «>» мы будем обозначать после-
довательность выбора пунктов меню. Например, File>Open будет оз-
начать, что в главном меню необходимо щелкнуть левой кнопкой 
мыши по File, а затем в выпадающем списке выбрать с помощью мыш-
ки или клавиатуры подменю Open (Открыть). Предполагается, что чи-
татель умеет пользоваться стандартными средствами операционной 
системы Windows. 

Обычно по умолчанию экран выглядит следующим образом (рис. 1.1): 
 

 

Рис. 1.1 

Слева окно менеджера объектов далее (Object Manager), справа 
основное окно программы «Плот окно» (Plot Window) для вывода карт 
и других графических объектов. Если окно менеджера объектов отсут-

ствует, то необходимо нажать в строке меню кнопку . В верхней части 
окна, на сером фоне расположены меню и панель с «инструментами». 
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1.1. Настройка программы (Preferences) 

Прежде, чем приступать к построению и выводу карт на экран (ок-
но Plot), желательно настроить систему определенным образом. Для это-
го необходимо зайти меню File>Preferences (Предпочтения) (рис. 1.2). 

 

 

Рис. 1.2 

Дважды щелкнем мышкой по закладке Drawing (Рисование) 
(рис. 1.3). 

 

 

Рис. 1.3 
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Сначала выберем Centimeters (Сантиметры) в качестве единиц 
измерения Page Units. Затем в разделе Default Attributes (Атрибуты по 
умолчанию) выберем Symbol (Символ, которым будут обозначаться 
скважины на карте, рис. 1.4). 

 

 

Рис. 1.4 

В строке выбора Symbol Set (Текущая таблица символов) найдем 
GSI Default Symbols. В качестве символа выберем закрашенный круг 
(символ под номером 12). Размер символа установим в строке выбора 
Size – 0.40 cm. Щелкнем по кнопке OK и вернемся в окно Preferences 

(рис. 1.3). Здесь в разделе Default Attributes (Атрибуты по умолчанию) 
щелкнем по кнопке Font. Появиться окно Text Properties (рис. 1.5). 

 

 

Рис. 1.5 
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Здесь выберем Face (Шрифт) – Times New Roman Cyr, для 
правильного отображения русских символов. Размер символа Points – 
14 и нажмем кнопку OK. Появится окно Preferences, которое мы то-
же закроем кнопкой OK и вернемся в главное окно программы Sur-

fer (рис. 1.1). 

1.2. Создание в окне таблицы XYZ файла данных 

Не вдаваясь пока в детали, построим в этом окне структурную 
карту по пяти точкам. Значения структурной поверхности в точках за-
даются в электронной таблице. При этом можно использовать встро-
енную в пакет таблицу или воспользоваться электронной таблицей 
Excel из пакета Microsoft Office. В данном примере воспользуемся 
встроенной таблицей, но заметим, что в текущей версии Surfer воз-
никают проблемы при использовании русского языка. Поэтому, если 
Вам необходимо использовать в таблице русские буквы, то лучше 
воспользоваться программой Microsoft Excel, в которой сохранить 
данные с расширением Excel 5.0/95. 

Для открытия окна таблицы в программе необходимо щелкнуть 

левой кнопкой мыши по иконке с изображением таблицы , находя-
щейся в верхней части окна (рис. 1.1). 

Примем для примера, что карту мы строим по продуктивному 
пласту А1, вскрытым разведочными скважинами на абсолютных отмет-
ках1 от 1,3 до 1,5 км со знаком минус (значит, вниз от уровня моря). 
В табличном виде это можно представить следующим образом: 

 

Таблица 
Глубина вскрытия разведочными скважинами кровли  

продуктивного пласта А1 

№  
скважины 

Абсолютная.  
отметка вскрытия  

кровли пласта А1, м 

Координата 
X, м 

Координата 
Y, м 

1 –1490 0 0 

2 –1445 3000 0 

3 –1300 1500 1500 

4 –1460 0 3000 

5 –1480 3000 3000 

                                                           
1 Под абсолютной отметкой понимается положение пласта от «уровня моря» – не-
кой условной геодезической поверхности, от которой отсчитываются все глубины 
и высоты на Земле. 
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В электронную таблицу эти данные занесем следующим обра-
зом. В первые два столбца удобнее занести координаты (именно там 
Surfer ищет их по умолчанию). В третий столбец занесем значения 
абсолютных отметок пласта (в ней по умолчанию программа ищет 
значение Z). Все заголовки таблицы сократим и запишем латинскими 
буквами. Пример заполнения встроенной электронной таблицы пред-
ставлен на рис. 1.6. 
 

 

Рис. 1.6 

Сохраним файл с табличными данными по скважинам в файле 
с именем АбсОтмКрПластА1. Расширение файла по умолчанию выби-
раем Excel SpreadSheet (*.xls). File>Save> АбсОтмКрПластА1.xls. 

Естественно, что название файла Вы можете задавать по сво-
ему усмотрению. Авторы рекомендуют создать для сохранения ре-
зультатов, например, на диске С: отдельный каталог и внутри него 
создать следующие подкаталоги: DAT – для сохранения файлов 
с данными, SET –для сохранения файла настроек Surfer, GRID – для 
сохранения сеточных файлов, SRF – для сохранения Plot окон, BLN – 
для сохранения файлов границ, CLR – для сохранения заливок карт. 
Соответственно сохраняемый табличный файл следует записать 
в подкаталог DAT. 
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1.3. Вывод на экран карты исходных точек (Post Map) 

Для визуализации в окне Plot1 точек расположения скважин на 
карте необходимо выбрать соответствующее окно Plot: меню > Window 
> Plot1. Когда программа создает новое окно Plot, она присваивает это-
му окну следующий по порядку номер. Поэтому окон Plot может быть 
несколько. В нашем случае только одно окно Plot1, и последователь-
ность действий будет следующая: Window > Plot1 > Map > PostMap > 
NewPostMap > C:\MySurfer\Dat\ АбсОтмКрПластА1.xls. 

В окне появятся скважины в виде черных кружков. При этом эк-
ран может выглядеть, как показано на рис. 1.7. 

 

 

Рис. 1.7 

В левом окне менеджера Объектов (далее Object Manager) дол-
жен появиться объект с именем Map который состоит из подобъекта 
Post (Точки) и четырех осей (Правой – Right Axis, Левой – Left Axis, 
Верхней – Top Axis и Нижней – Bottom Axis). 

Если вместо кружочков точки скважин будут отображаться кре-
стиками, то они будут сливаться с осями карты (рис. 1.8). 
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Рис. 1.8 

Настроить вид карты Post можно в диалоговом окне свойств объ-
екта. Для этого необходимо дважды щелкнуть по подобъекту Post в Ob-

ject Manager, либо по его представлению в окне Plot1. Откроется диа-
логовое окно свойств объекта Map: Post Properties (рис. 1.9) В первой 
закладке General (Общие) можно посмотреть и при необходимости из-
менить координаты X и Y символа, изменить символ (Default Symbol), 
его размеры (Symbol Size) и т. д. (рис. 1.10). 

 

 

Рис. 1.9 
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Рис. 1.10 

Вид каждой из осей можно настраивать отдельно, но в данном 
случае мы рекомендуем их отключить, убрав, «галочки» в Object 

Manager. 
Для того, чтобы подписать скважины, зайдем на закладку Labels 

(рис. 1.11). 
 

 

Рис. 1.11 
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В строке выбора Worksheet Column for Labels (Столбец для 
подписей) None изменим на Column D:N-Skv, как показано на рис. 1.11 
и в строке выбора Position Relative to Symbol (Позиция относительно 
символа) выберем Above (Сверху) (рис. 1.12). 
 

 

Рис. 1.12 

 

Рис. 1.13 
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Для того, чтобы изменения в окне вступили в силу необходимо 
щелкнуть мышкой по кнопке Apply (Применить) и для окончания ра-
боты с диалоговым окном по кнопке ОК. 

На рис. 1.13 показан результат вывода на экран номеров скважин. 
Чтобы изменить размер и вид шрифта в диалоговом окне 

(рис. 1.12), необходимо щелкнуть по кнопке Font и в строке Faсe вы-
брать соответствующий шрифт (например, ArialCYR), а размер шрифта 
изменить в Points (рис. 1.5). 

1.4. Вывод на экран карты в изолиниях (Contour Map) 

Прежде, чем вывести карту в изолиниях на экран необходимо 
пересчитать нерегулярные данные в регулярную прямоугольную сет-
ку, которая сохраняется в формате файла с расширением *.grd (ГРИД). 
Для этого укажем системе файл с исходными данными: Grid > 
Data>C:\MySurfer\Dat\ АбсОтмКрПластА1.xls и попадем в диалоговое 
окно расчета ГРИДА (Grid Data) (рис. 1.14). 

 

 

Рис. 1.14 

Необходимо убедиться, что в качестве столбца с координатами Х 
выбран Column A: X_skv, соответственно координате Y соответствует 
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столбец Column B: Y_skv и значению абсолютных отметок Z соответст-
вует Column С: ao_krA1. 

Группа «Gridding Method» (Метод гриддинга) позволяет выбрать 
нужный пользователю метод сеточной интерполяции. Выбор метода 
зависит от поставленной задачи. Оптимальным методом интерполя-
ции, подходящим для большинства задач, считается метод Крайгинга 

(Kriging). Метод назван в честь Д.Г. Криге, южноафриканского горно-
го инженера. Этот метод является геостатистическим методом грид-
динга (гриддинг – сеточная интерполяция). Он отличается быстродей-
ствием и корректным приближением интерполированных в узлы 
значений параметра к его исходным значениям. 

В качестве метода интерполяции выбираем Kriging и щелкаем по 
кнопке ОК. По умолчанию система высвечивает на экране окно с сооб-
щением, что расчет завершен и указанный сеточный файл *.grd создан 
(has been created) (рис. 1.15). 

 

 

Рис. 1.15 

Кроме этого, в окне Grid Report выводится информация о по-
строенной регулярной сетке. Отключить окно Grid Report (отчет о по-
строении сеточного файла) можно, убрав «галочку» в соответствующем 
разделе (рис. 1.14). 

Для визуализации рассчитанного ГРИДА в виде карты на экране 
необходимо выбрать меню > Map > Contour Map > New ContourMap > 

C:\MySurfer\Dat\ АбсОтмКрПластА1.grd. В окне Plot1 появится карта 
в изолиниях, а в Object Manager появится новый объект Map c подобъ-
ектом Contours (рис. 1.16). 

Для объединения карты скважин с картой изолиний в один объект 
нажмем на клавиатуре функциональную клавишу F2 и последовательно 
выберем пункты меню: Map > Overlay Maps (рис. 1.17). 

На этом простом примере видно, что процедура создания на экра-
не карты в изолиниях состоит из трех основных этапов: 

 создания таблицы исходных точек; 
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Рис. 1.16 

 

Рис. 1.17 
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 пересчета значений из таблицы исходных точек в прямоугольную 
сетку; 

 вывода и оформления карты в окне Plot1. 
В качестве самостоятельной работы Вы можете вывести на экран 

через знакомое меню Map рассчитанный ГРИД в виде трехмерного изо-
бражения – Surface, карты затененного рельефа – Shaded Relief Map 
и объемного представления карты в виде каркаса – Wireframe. 

Отметим некоторые особенности оформления карт. Во-
первых, местоположение подписей точек (в нашем случае это номе-
ра скважин) можно менять относительно центров точек, но для всех 
точек одновременно и на одно и то же расстояние. Подпись может 
располагаться над точкой (Above), под точкой (Below), справа от 
точки (Right), слева от точки (Left), по центру (Center), также мож-
но задавать положение подписи пользователем (User Defined) в ко-
ординатах относительно центра точки. 

На рис. 1.18 показано, как в окне свойства точек (Post Properties), 
открытом на закладке Labels (Метки, подписи), можно менять относи-
тельное положение Подписей (Меток) в списке выбора, озаглавленном 
Position Relative to Symbol (Позиция относительно символа). Под-
черкивание первой буквы Р в слове Position означает, что к этому списку 
выбора можно обращаться нажатием клавиш Alt+P. Это стандартное со-
глашение системы Windows, позволяющее быстро нажатием пары кла-
виш выполнять определенное в меню действие. 

 

 

Рис. 1.18 
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В случае задания положения подписи пользователем (User De-

fined) необходимо задать относительное положение Метки от центра 
точки по координате Х (X Offset) и Y (Y Offset). При этом необходимо 
помнить, какие единицы измерения выбраны в меню Preferences– сан-
тиметры или дюймы (Inches). 

Границы сетки (контурной карты) определяют максимальные 
и минимальные значения координат X и Y (по умолчанию в Surfer уста-
навливаются минимум и максимум X и Y из файла данных АбсОтмКр-
ПластА1.xls). При этом скважины попадают на края карты (рис. 1.17). 

Для того, чтобы скважины находились внутри карты необходи-
мо построить новый ГРИД с расширенной областью его построения. 
Сначала разъединяем карты. Выбираем в Object Manager подъобъект 
Contours и осуществляем последовательность действий: Map > Break 

Apart Overlay. 
 

 

Рис. 1.19 

Выполняем уже знакомые нам действия при расчете ГРИДА: Grid 

> Data>C:\MySurfer\Dat\ АбсОтмКрПластА1.xls и попадем в диалоговое 
окно Grid Data, где даем новое имя в поле Output Grid File (выходной 
сеточный файл) и в полях Grid Line Geometry (Геометрия линий ГРИ-
ДА) по обоим направлениям X и Y на несколько метров уменьшаем 
Minimum (минимальное значение координаты) и увеличиваем Maximum 
(максимальное значение координаты) (рис. 1.19). 
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Следует отметить, что эти отклонения от минимального и мак-
симального значений координат не должны быть большими, иначе по-
грешность построения изолиний около границы карты будет весьма 
существенной. 

Группа Grid Line Geometry определяет не только границы сетки 
(Minimum, Maximum), но и ее плотность (шаг сетки – Spacing, число 
линий – # of Lines). 

При комбинировании нескольких карт следует помнить, что на-
чальные и конечные координаты на всех картах должны быть идентич-
ны. То же касается и шагов сетки. Плотность сетки определяется чис-
лом линий сетки по направлениям X, Y и зависит от плотности 
исходных данных. При расчете сетки для конкретной карты необходи-
мо исходить из того, что шаг Spacing должен быть равен или меньше 
расстояния между исходными точками данных. На основании этого 
рассчитывается шаг сетки. По умолчанию в SURFER плотность сетки 
принята равной 100 × 100 сеточных линий. 
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Рис. 1.20 

Выполнив те же действия, что и при построении объединенной 
карты, представленной на рис. 1.16, т. е. построив новую карту: Map > 
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Contour Map > New ContourMap по новому ГРИДУ и объединив ее 
с картой скважин, которая уже есть, Вы получите карту (рис. 1.20), где 
скважины находятся внутри карты. 

При этом по умолчанию каждая пятая изолиния будет подпи-
сана. Подписать изолинии при необходимости или не подписывать 
их вообще Вы можете, выбрав в Object Manager подобъект Con-

tours и двойным щелчком левой кнопки мыши открыв диалоговое 
окно его свойств MAP: Contours Properties. Заходим на закладку 
Levels (рис. 1.21). 

 

 

Рис. 1.21 

В колонке Lable (Метка) каждая помеченная на карте изолиния 
обозначена словом Yes. Нажмем кнопку Lable. В открывшемся окне 
Lables (рис. 1.22) можно изменить частоту подписи изолиний, напри-
мер, заменив в поле Skip цифру 4 на 2 и последовательно нажав кноп-
ки OK>Applay, получим карту, где подписана каждая третья изолиния 
(рис. 1.23). Можно подписывать изолинии выборочно, выделив слово 
No и двойным щелчком мыши поменяв его на слово Yes, Например, ес-
ли нет необходимости подписывать изолинии вообще, то окно MAP: 
Contours Properties и карта будут выглядеть так, как показано 
на рис. 1.24 и 1.25 соответственно. 
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Рис. 1.22 
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Рис. 1.23 
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Рис. 1.24 

 

Рис. 1.25 
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В отличие от ручного при компьютерном построении карт требу-
ется выбирать метод расчета ГРИДА и задавать определенный для каж-
дого метода набор параметров, от выбора которых зависит форма ре-
зультирующей карты. Искусство построения карт на компьютере 
напрямую зависит от умения правильного подбора параметров. С дру-
гой стороны, необходимо представлять себе, какие погрешности возни-
кают при расчете ГРИДА и как их можно минимизировать. 

В общем случае процесс пересчета значений картируемого пара-
метра из нерегулярных исходных точек к равномерным узлам сетки 
происходит следующим образом. 

Прежде всего должна быть задана сетка, в узлах которой будут 
рассчитываться значения картируемого параметра (рис. 2.1). 

Размеры этой сетки в программе Surfer могут быть заданы поль-
зователем или автоматически рассчитаны средствами системы. Геомет-
рия сетки определяется шагом (расстоянием) между узлами по оси Х 
и шагом (расстоянием) между узлами по оси Y. Это расстояние должно 
соотносится с плотностью точек исходных данных: чем выше плотность 
данных, тем меньше должно быть расстояние между узлами сетки. 
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Рис. 2.1 
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Surfer по некоторому алгоритму с использованием исходных 
данных рассчитывает значение в узле сетки. Выбор конкретного алго-
ритма имеет значительное влияние на окончательный вид карты. 

2.1. Некоторые алгоритмы расчета сетки (Grid), 
реализованные в пакете Surfer 

Если Вы уже пробовали открыть построенную в первой главе 
(БЫСТРОЕ НАЧАЛО) поверхность не только в виде карты в изолиниях 
(Сontour Map), но и виде трехмерной поверхности (Surface), каркасной 
карты (Wireframe), карты затененного рельефа (Shaded Relief Map), 
векторной карты(Vector Map) и карты растра (Image Map), то Вы дога-
дались, что все эти виды карт основаны на равномерной сетке, представ-
ленной файлом с расширением *.grd. Далее эту сетку будем чаще всего 
так и называть – GRID (ГРИД), а процедуру создания GRID в программе 
Surfer – гридингом (gridding). ГРИД представляет собой таблицу, где 
каждому узлу ГРИДА с координатами X(i) и Y(i) соответствует опреде-
ленное значение Z. В 8 версии программы Surfer реализованы 12 алго-
ритмов расчета регулярной сетки. В данной работе не предусматривается 
подробного их рассмотрения. Вы можете исследовать каждый из методов 
и выбрать наиболее подходящий для себя. Мы же используем только те 
методы, которые нам потребуются для решения конкретных задач. 

2.2. Построение сеточного файла по заданной функции 

Прежде, чем сформулировать наши задачи, рассмотрим еще одну 
замечательную возможность программы Surfer – генерировать ГРИД 
без исходных данных, используя только математические функции. Для 
этого выполним: Grid > Function. При этом на экране появится сле-
дующее диалоговое окно (рис. 2.2). 

 

 

Рис. 2.2 
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Определимся с областью построения ГРИДА. Размеры карты 
примем 6 км × 9 км. В масштабе 1:50 000 это составит 12 см × 18 см., 
где разница между максимальным и минимальным значениями коорди-
наты X составляет 6000 м, а координат Y соответственно 9000 м. 

 
Таблица 

 По координате X, м По координате Y, м 

Минимальное 1000 1000 

Максимальное 7000 10000 

 
Сетку рассчитаем равномерную с шагом 100 м × 100 м. Абсолютные 

отметки поверхности Z зададим в виде аналитической функции, например: 

z = –2400 + x*1.6/900 + Cos(y/1000)*9.6-Sin(x/950)*11.4 (рис. 2.3). 

 

 

Рис. 2.3 

 

Рис. 2.4 
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По умолчанию программа предлагает сохранить файл с названи-
ем out.grd. Отобразим полученный результат: Map > Surface > out.grd 
(рис. 2.4). Таким образом, с помощью программы Sufer можно изучать 
аналитическую геометрию. В нашем случае мы попытались смодели-
ровать антиклинальную складку с ундулирующими осями по направ-
лениям X и Y (линия оси представляет собой некую кривую, теорети-
чески, это может быть, например, синусоида). Реальную поверхность 
этим способом построить невозможно, поскольку реальные поверхно-
сти обычно нельзя описать какой-либо функцией. Построение реаль-
ных поверхностей проводится, как правило, по известным точечным 
значениям через меню Grid>Data. Но способ построения поверхности 
с помощью аналитической функции необходим, т.к c его помощью 
можно создавать сеточные файлы, в которых значение Z является кон-
стантой, т. е. поверхность представляет собой плоскость. При построе-
нии Grid обычным способом (Grid>Data…), если все значения в ис-
ходных точках равны, программа выдаст сообщение об ошибке 
(рис. 2.5) – все данные лежат на одной плоскости. 

 

 

Рис. 2.5 

 

Рис. 2.6 
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В качестве плоскости часто принимаются межфлюидальные кон-
такты в залежах – ВНК (водонефтяной контакт), ГВК (газоводяной кон-
такт) и ГНК (газонефтяной контакт). 

Прежде, чем построить гипотетическую плоскость водонефтяного 
контакта в нашей смоделированной структуре, ознакомимся с ее пара-
метрами. Параметры полученной сетки out.grd можно посмотреть 
в свойствах построенной по данной сетке карты в изолиниях. 

 

 

Рис. 2.7 
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Выбрав в Object Manager эту карту, следует щелкнуть по ней два 
раза до появления окна Map: Contours Properties и щелкнуть по значку 
i (рис. 2.6) (Grid Info – информация о ГРИДЕ). В окне текстового ре-
дактора будет сформирован отчет, в котором приводятся геометриче-
ские и статистические данные по этому ГРИДУ (рис. 2.7). 

 
Grid Information – Основные характеристики сеточного файла (Grid) 
 
Sun Nov 04 12:23:32 2007 – дата и время создания отчета 
 
Grid File Name: E:\Vit\GoldenSoftTheory\SurferTheory\out.grd (Имя фай-
ла и его расположение на диске) 
Grid Size (Размер грида): 91 rows(строк) x 61 columns (столбцов) 
Total Nodes (Всего узлов): 5551 
Filled Nodes (Количество непустых узлов): 5551 
Blanked Nodes (Количество узлов, заполненных значением пусто): 0 
 
Grid Geometry (Геометрия сетки) 
 
X Minimum(Минимальное значение по Х(левый нижний угол)): 1000 
X Maximum((Максимальное значение по Х(правый верхний угол)): 7000 
X Spacing (Шаг сетки по оси Х): 100 
 
Y Minimum(Минимальное значение по Y(левый нижний угол)): 1000 
Y Maximum((Максимальное значение по Y(правый верхний угол)): 
10000 
Y Spacing (Шаг сетки по оси Y): 100 
 
Grid Statistics (Статистическая характеристика грида) 

 
Z Minimum(Минимальное значение Z): –2418.4544511977 
Z 25%-tile (Первый квартиль): –2403.0160641508 
Z Median(Медиана): –2393.73726463 
Z 75%-tile(Третий квартиль): –2386.2434387159 
Z Maximum(Максимальное значение): –2370.9193548939 
 
Z Midrange(Среднее значение между крайними): –2394.6869030458 
Z Range(Размах): 47.535096303775 
Z Interquartile Range(Межквартильный размах): 16.77262543496 
Z Median Abs. Deviation (Абсолютное отклонение от медианы): 
8.4145258170824 
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Z Mean (Среднее арифметическое значение):–2394.5795648877 
Z Trim Mean (10 %): –2394.5098473792 
Z Standard Deviation(Стандартное отклонение): 11.725160476045 
Z Variance(Дисперсия): 137.47938818901 
 
Z Coef. of Variation (коэффициент вариации): –1 
Z Coef. of Skewness (коэффициент скошенности): –0.12177126117251 
 
Z Root Mean Square (корень квадратный из среднеквадратичного): 
2394.6082710886 
Z Mean Square (среднее в квадрате): 5734148.7719661 
 

В данном случае мы обратим внимание на основные геометри-
ческие характеристики ГРИДА, которые всегда необходимо учиты-
вать при математических операциях с картами. Это координаты ле-
вого и правого углов сетки и шаг по координате Х и по координате 
Y. Из статистических характеристик обратите внимание на мини-
мальное и максимальное значение Z. В процессе работы, контроли-
руя эти значения, можно избежать ряда ошибок, в результате кото-
рых значения картируемого параметра Z выходят за разумные 
пределы. Например, толщина пласта принимает отрицательные зна-
чения. Анализ остальных характеристик ГРИДА зависит от физиче-
ской сущности картируемого параметра. Выберем значение третьего 
квартиля (–2386.2 м) в качестве абсолютной отметки проведения 
ВНК. Третий квартиль означает, что 25 % значений Z на карте име-
ют абсолютную отметку выше –2386.2 м. 

 

 

Рис. 2.8 
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Для расчета плоскости, имеющей значение, равное –2386.2, не-
обходимо зайти в диалоговое окно расчета ГРИДА по функции 
(Grid>Function) и в открывшемся окне Grid Function задать сле-
дующие значения (рис. 2.8). 

Мы задаем в качестве значения Z константу –2386.2. Геометрию 
сетки (координаты левого нижнего и верхнего правого узла и шаг сетки 
по Х и по Y) оставляем такими же, как и при расчете файла out.grd. 
Файл называем ВНК-2386,2.grd и щелкаем по кнопке ОК. Загружаем 
полученный ГРИД в виде трехмерной поверхности Map > Surface. Если 
после этого загрузить out.grd и совместить с картой ВНК (F2 > Map > 
Overlay Maps), мы увидим на экране, как пересекаются плоскость ВНК 
с смоделированной нами поверхностью пласта (рис. 2.9). 

 

 

Рис. 2.9 

В качестве закрепления пройденного материала постройте на-
клонный ВНК (рис. 2.10). 

Для этого зададим ту же геометрию сетки, но вместо постоянного 
числа для расчета Z используем линейную зависимость 

Z=–2403+x*5/1000, 

где в качестве константы использовано значение, например, первого 
квартиля, а в качестве изменяемого параметра – координата Х. При этом 
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для первого значения координаты Х=1000 значение абсолютной отмет-
ки Z=–2403+1000*5/1000=–2398, а для конечного значения Х=7000 зна-
чение абсолютной отметки Z=–2403+7000*5/1000=–2368. Другими сло-
вами, по координате Х значение Z будет меняться от –2398 до –2368. 
Файл сохраним под именем Наклонный ВНК.grd. Убедимся в том, что 
значения Z изменяются в указанном диапазоне, просмотрев отчет по 
свойствам рассчитанного ГРИДА. 

 

 

Рис. 2.10 

2.3. Построение плоскости наклонного ВНК  
по заданным в определенных точках значениям 

Естественно, наклонный ВНК можно построить и по нерегулярной 
сетке точек. Для того, чтобы исследовать данную возможность попытаем-
ся построить карту наклонного ВНК с теми же параметрами, что и карту, 
рассчитанную через функцию. Для этого создадим файл с четырьмя точ-
ками, в которых нам известно положение ВНК. Пусть для простоты коор-
динаты этих точек будут равны угловым координатам нашей карты, а зна-
чение Z по координате Х будет изменяться от –2398 до –2368. Для этого 
создадим новую таблицу, занесем в нее соответствующие значения и со-
храним под именем 4ТочкиНаклонногоВНК.xls (рис. 2.11). 
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Рис. 2.11 

Для построения карты зайдем в меню Grid>Data и выберем 
в качестве файла исходных данных 4ТочкиНаклонногоВНК.xls. За-
дадим принятую геометрию ГРИДА (рис. 2.11). Не забудем, что рас-
стояние между узлами по Х и по Y равно 100 м, а количество узлов 
по Х – 61, по Y – 91. Название ГРИДА оставляем по умолчанию 
4ТочкиНаклонногоВНК.grd. В качестве метода построения выбе-
рем Kriging. Если построенный ГРИД визуализировать на экране как 
трехмерную поверхность, то можно даже и не увидеть различий 
с картой, построенной через функцию (Наклонный ВНК.grd), но 
вывод ее на экран в виде карты изолиний (Contour Map) или внима-
тельный анализ статистических свойств покажет, что карта, постро-
енная по ГРИДУ 4ТочкиНаклонногоВНК.grd, не является плоской 
поверхностью. Для убедительности построим карту различий. Для 
этого вычтем из одного ГРИДА другой: Grid>Math (рис. 2.12). 

В качестве первого файла (Input Grid File A) выбираем 
4ТочкиНаклонногоВНК.grd в качестве второго файла (Input Grid File 
В) выбираем Наклонный ВНК.grd. Результирующий ГРИД (Output 
Grid File C) сохраняем под именем КартаРазличийНаклонВНК.grd. 

Строим карту как трехмерную поверхность, затем карту в  изо-
линиях Contour Map и объединяем их в один объект: нажмем кла-
вишу F2 и последовательно выберем пункты меню Map > Overlay 

Maps (рис. 2.13). 
Если посмотреть статистику по файлу КартаРазличийНа-

клонВНК.grd, то максимальные расхождения между ГРИДАМИ, по-
строенными разными способами, изменяются от –3.486 м до +3.486 м, 
то есть отличия весьма заметны. 
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Рис. 2.12 

 

Рис. 2.13 

Попробуем построить карту по 4 точкам, используя другой метод 
построения ГРИДА (Gridding Method), проделав необходимые процеду-
ры выбора меню: 
1. Grid>Data. 
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2. В диалоговом окне Open выберем файл 4ТочкиНаклонногоВНК.xls. 
3. В диалоговом окне Grid Data в группе Gridding Method выберем 

Polynomial Regression (полиномиальную регрессию). 
В геометрии ГРИДА по-прежнему поставим шаг по Х и Y, рав-

ным 100 м. Зададим имя выходного файла 4ТочкиНаклонногоВНК2.grd 
и нажмем ОК. Заданный ГРИД будет создан. Карту можно вывести 
на экран как в виде поверхности, так и в форме карты изолиний. По-
скольку визуально мы можем не всегда увидеть существенные раз-
личия между картами, то повторим процедуру вычитания карт, 
т. е. из файла с именем 4ТочкиНаклонногоВНК2.grd вычтем файл 
НаклонныйВНК.grd. Результирующий файл назовем КартаРазли-
чийНаклонВНК2.grd. Если сейчас попытаться построить карту в изо-
линиях, компьютер выдаст сообщение о невозможности построения 
карты в изолиниях (рис. 2.14). 

 

 

Рис. 2.14 

 

Рис. 2.15 
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В свойствах файла КартаРазличийНаклонВНК2.grd, нажав 
кнопку Grid Info (Информация о ГРИДе) убедимся, что эти различия 
равны 0, т. е. полученные файлы 4ТочкиНаклонногоВНК2.grd, по-
строенный по 4 точкам исходных данных с применением метода поли-
номинальной регрессии и файл НаклонныйВНК.grd, построенный 
по заданной функции, абсолютно одинаковы (рис. 2.15). Самостоя-
тельно построив карту в трехмерном изображении, убедитесь, что это 
плоскость Z=0 (рис. 2.16). 

 

 

Рис. 2.16 

Полиномиальная регрессия не является истинным интерполяцион-
ным методом, потому что она не позволяет предсказывать неизвестные 
значения Z, но с ее помощью можно выявить крупномасштабный тренд 
данных. Тренд-анализ можно рассматривать как вариант статистического 
метода множественной регрессии [2]. Уравнение множественной регрес-
сии позволяет наилучшим образом оценить совместное влияние многих 
параметров на результат наблюдения. Тренд-анализ – это чисто геологи-
ческое название математического метода разделения двух компонент: 
систематической (региональной) и случайной (локальной). Тренд-
поверхности строятся путем аппроксимации исходных данных полино-
мами различных степеней. Понятия «региональный» и «локальный» 
весьма субъективны. Они в значительной степени зависят и от размеров 
изучаемого региона, и от имеющихся данных, и от цели геологического 
исследования. Некоторые опции (кнопка Advanced Options в диалоговом 
окне Grid Data) позволят Вам выбрать тип «тренд-поверхности». 
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Аналогично восстановить плоскую наклонную поверхность Вы 
можете, выбрав в качестве метода сеточной интерполяции, например, 
Triangulation with Linear Interpolation (триангуляцию).(рис. 2.17). 

Предлагается в качестве самостоятельного задания выполнить соот-
ветствующие действия и, построив карту различий, убедиться, что и для 
данного метода построения сеточного файла различия также равны нулю. 

 

 

Рис. 2.17 

Таким образом, для каждой конкретной задачи выбирается свой 
метод построения сеточных файлов. Различные gridding-методы могут 
дать различные результаты при интерпретации (расшифровке) данных. 
С большинством наборов данных griddin-метод по умолчанию – 
Kriging, поскольку он генерирует самую полную интерпретацию боль-
шинства наборов данных. Вообще этот метод мы рекомендуем для наи-
более частого использования. Kriging – один из наиболее гибких мето-
дов и полезен для gridding почти любого типа набора данных. 
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Для построения разреза (сечения) карты необходимо иметь: 
 ГРИД-файл формата [.GRD]; 

 линию разреза, по которой будет построен разрез в виде файла 
формата [.BLN]. 
После выполнения последовательных команд меню Grid > 

Slice будет создан файл [.DAT] (вертикальное сечение ГРИДА вдоль 
линии разреза) с данными, необходимыми для вывода разреза на эк-
ран. Следовательно, направление разреза будет зависеть от направ-
ления линии разреза. 

В геологии существуют определенные правила ориентировки раз-
резов по странам света: 

 Юг – слева; 
 Север – справа; 

 Юго-Запад, Юго-Восток – слева; 

 Северо-Запад, Северо-Восток – справа. 
Существуют некоторые различия в терминах «разрез» и «про-

филь». При этом под разрезом, как правило, понимается сечение карты 
по прямой линии, а под профилем линия может быть ломаной и часто 
такой профиль строится по скважинам. Естественно, соблюсти правила 
ориентировки профиля удается не всегда, потому что он может начи-
наться на Юго-Западе, а заканчиваться на Юго-Востоке. В любом слу-
чае хорошим правилом является подписывать края профиля и приво-
дить схему его расположения на карте. 

3.1. Структура файла разреза 

Созданный в процессе выполнения 
команды меню Grid > Slice файл является 
обычным текстовым (ASCII) файлом, со-
стоящим из пяти столбцов с данными. 
Значения Z картируемого параметра на 
профиле рассчитываются для каждого пе-
ресечения линии профиля с линиями сетки 
карты, так называемыми грид-линиями 
(рис. 3.1). Следовательно, детальность про-
филя зависит от плотности узлов нашей ма-
тематической поверхности (ГРИДА). 

 

Рис. 3.1 
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Содержание столбцов в результирующем файле разреза [.DAT] 
 

Столбец A Координата X пересечения линии профиля с грид-линией карты 
(вертикальной или горизонтальной) 

Столбец B  Координата Y пересечения линии профиля с грид-линией карты 
(вертикальной или горизонтальной) 

Столбец C  Значение Z в точке пересечения линии профиля с грид-линией 
карты (вертикальной или горизонтальной) 

Столбец D  В столбце D содержится накопленное горизонтальное рас-
стояние от начала профиля вдоль линии профиля. Это рас-
стояние накапливается даже тогда, когда линия профиля вы-
ходит за границу ГРИДА. Начинается это расстояние для 
каждого профиля, естественно, с нуля.  

Столбец E В столбце E записывается номер профиля. В одном [.BLN] фай-
ле можно задать несколько профильных линий, по которым бу-
дут рассчитаны сечения ГРИДА. Условный номер по порядку 
будет подписан в пятом столбце E. Если у Вас одна линия про-
филя, то в нем соответственно будет стоять значение 1. 

 

3.2. Создание файла данных разреза 

Последовательность действий при создания файла разреза скла-
дывается из следующих шагов: 
1. Выбрать в меню команду Grid > Slice. 
2. В диалоговом окне Open Grid, выбрать соответствующий файл *.grd 
и щелкнуть по кнопке Open (Открыть). 
3. В следующем диалоговом окне Open, выбрать файл [.BLN] с коорди-
натами линии профиля (о создании этого файла речь пойдет ниже), по 
которой будет рассчитан разрез и щелкнуть по кнопке Open. 
4. Задать имя выходного файла (Output DAT File) и щелкнуть по кноп-
ке Save (Сохранить). 
6. Указать в опции Set values outside (Установите значения за преде-
лами), какие значения присваивать точкам, лежащим за пределами 
ГРИДА. По умолчанию значение в этих точках рассчитывается по сле-
дующему уравнению: 

(1.4 * Grid Z Minimum)-(0.4* Grid Z Maximum). 

Если эта опция неактивна (отсутствует «галочка»), то значения 
точек, выходящих за пределы ГРИДА в выходной файл формата [.DAT] 
не включаются. 
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7. В опции Set values in blanked grids (Установите значения в блан-
кированных областях ГРИДА) указывается, какое значение картируе-
мого параметра присвоить на участках, где в узлах сетки стоит специ-
альное значение (Blanking value), лежащее внутри бланкированных 
областей. Под бланкированной областью понимается, например, об-
ласть отсутствия продуктивного пласта. Расчет значения по умолчанию 
осуществляется так же, как и в пункте 6. Если опция неактивна, эти об-
ласти «пропускаются», т. е. не включаются в выходной файл. 
8. Щелкнуть по кнопке OK, и файл с данными ГРИДА по линии профи-
ля будет создан. 

3.3. Практическое построение профильного разреза 

Для геологов-нефтяников основным объектом исследования, как 
правило, является залежь – единичное скопление нефти или газа в зем-
ной коре. Одним из видов залежи является пластово-сводовая залежь. 
Такая залежь представляет собой проницаемый пласт, ограниченный 
в ровле и подошве практически непроницаемыми породами и изогну-
тый в форме свода. Нефть или газ заполняют верхнюю ее часть, а ниж-
нюю заполняет пластовая вода. Следует различать термины резервуар, 
ловушка и залежь. Резервуар – это проницаемый пласт-коллектор, ог-
раниченный практически непроницаемыми породами. Ловушка – это 
часть резервуара, в котором существуют условия для накопления и со-
хранения залежей углеводородов. А залежь – это ловушка, содержащая 
промышленные количества нефти или газа. Эти вопросы рассматрива-
ются в курсе нефтепромысловой геологии. 

Схема строения пластово-сводовой залежи приводится на рис. 3.2. 
 

непроницаемые
породы нефть

вода
кровля

подошва

водонефтяной
 контакт(ВНК)

 

Рис. 3.2 
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Для построения разреза пластово-сводовой залежи необходимы 
два ГРИДА: 
1. ГРИД по кровле проницаемого пласта. 
2. ГРИД по подошве проницаемого пласта. 

 
Для построения карт используем следующие исходные данные: 
 

X, м Y, м Z кровли, м Z подошвы, м скважины 

2608 3921 –2800 –2834 1 

1879 2900 –2700 –2726 2 

1100 1708 –2600 –2634 3 

444 517 –2700 –2716 4 

–67 –529 –2800 –2820 5 

–553 3751 –2750 –2786 6 

347 2681 –2650 –2672 7 

2122 492 –2650 –2668 8 

3070 –772 –2750 –2780 9 

3313 1806 –2750 –2780 10 

2146 1684 –2650 –2678 11 

152 1611 –2650 –2678 12 

–821 1271 –2750 –2770 13 

 
Абсолютная отметка ВНК: – 2730 м. 
Построим карту скважин в новом пустом окне Plot2 и, зайдя на 

закладку Lables, вместо номеров скважин выведем абсолютные отметки 
кровли (рис. 3.3). 

 

 

Рис. 3.3 
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После нажатия кнопки OK получим карту скважин (рис. 3.4). 
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Рис. 3.4 

Затем построим карту по кровле пласта методом Minimum Cur-

vature (Минимальное искривление). При расчете ГРИДА расширяем 
область его построения (рис. 3.5), даем имя выходному сеточному 
файлу, например, кровля.grd. Затем объединяем обе карты. Результат 
приведен на рис. 3.6. 

 

 

Рис. 3.5 
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Рис. 3.6 

Чтобы карта стала в точности похожей на приведенную, необхо-
димо, воспользовавшись Object Manager, выбрать подобъект Contours 

и двойным щелчком мыши открыть диалоговое окно его свойств MAP: 
Contours Properties, зайти на закладку Levels и нажать кнопку Level. 

В открывшемся окне Contour Levels выставить Interval (Интервал ме-
жду изолиниями) равным 20 (рис. 3.7). По умолчанию он равен 50. 
Нажимаем в этом окне OK и затем кнопку Applay. 

 

 

Рис. 3.7 
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Далее уменьшим размер шрифта подписанных изолиний. Для 
этого нажмем кнопку Lable и в открывшемся окне Lables (рис. 3.8) 
кнопку Font. 

 

 

Рис. 3.8 

В открывшемся окне (рис. 3.9) установим размер шрифта – 12, 
OK>OK>Applay. 

 

 

Рис. 3.9 

Обратим внимание (рис. 3.6), что подпись изолинии –2740 рас-
положена очень близко к скважине. Выберем в Object Manager по-
добъект Contours, правой кнопкой мыши откроем контекстное меню, 
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в нем выберем пункт Edit Contour Lables (Редактор меток изолиний) 
и появившейся черной стрелкой сдвинем подпись изолинии или удалим 
ее клавишей Delete (рис. 3.10). Чтобы отменить режим редактора ме-
ток изолиний, необходимо вновь воспользоваться контекстным меню 
и елкнуть левой кнопкой мыши по пункту Edit Contour Lables. 
 

 

Рис. 3.10 

 

Рис. 3.11 

Заметим, что можно одновременно нанести на карту и номера 
скважин, и абсолютную отметку. Для этого нужно построить еще одну 
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карту Post Map, открыть диалоговое окно ее свойств, зайти на заклад-
ку Lables и вывести номера скважины из таблицы файла данных, отре-
гулировав его положение относительно символа с помощью User De-

fined (рис. 3.11), щелкнуть по кнопке Font и поставить «галочку» в оле 
Underline, чтобы подчеркнуть номер скважины (рис. 3.12), нажать OK. 
В окне Map: Post Properties нажать кнопку Apply. Затем необходимо 
вернуться на закладку General и выбрать «немой» символ, например, 
под номером 115 (рис. 3.13). Дважды нажимая OK, получим карту, 
приведенную на рис. 3.14. Затем выделяем и объединяем все три кар-
ты: Map>Overlay Maps (рис. 3.15). 

 

 

Рис. 3.12 

 

Рис. 3.13 
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Рис. 3.14 
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Рис. 3.15 
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Отметим линию ВНК на карте. В Object Manager открываем окно 
свойств подобъекта Contours, заходим на закладку Levels. В первом 
столбце Level находим абсолютную отметку, близкую к заданной абсо-
лютной отметке уровня ВНК, например, –2720 (рис. 3.16) и нажимаем 

кнопку Add (Добавить). 
 

 

Рис. 3.16 

Появится дополнительная изогипса –2730, которую можно отре-
дактировать в столбце Line (рис. 3.17). 
 

 

Рис. 3.17 
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Двойным щелчком левой кнопки мыши открываем окно Line 

Properties и выбираем стиль (Style), цвет (Color) и толщину (Width) 
линии, соответствующей абсолютной отметке ВНК (рис. 3.18). 
 

 

Рис. 3.18 

В этом окне нажимаем OK, в открывшемся окне – Apply и OK 

(рис. 3.19). 
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Рис. 3.19 
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Прежде, чем построить профильный разрез, необходимо создать 
файл с координатами линии профиля, по которой он будет рассчитан. Вы-
деляем карту и включаем режим оцифровки: Map>Digitize. Появившимся 
крестом щелкаем левой кнопкой мыши в верхнем левом углу карты, затем 
по скважинам с номерами 7, 3, 6 и в нижнем правом углу карты. В от-
крывшемся небольшом окне digit.bln появляются координаты выбранных 

скважин Х и У. В этом же окне: File>Save as и рисваиваем файлу с коор-
динатами предложенное по умолчанию имя digit.bln, закрываем окно 
и тменяем режим оцифровки (снимаем «галочку» в Map>Digitize). 

Откроем файл digit.bln (рис. 3.20). В первой строке в файлах 
данного формата всегда в первой ячейке указывается количество дан-
ных, во второй – либо ноль, либо единица. Построим линию разреза: 
Map> Base Map, в открывшемся окне Import File (рис. 3.21) выбираем 
файл digit.bln>Открыть. 

 

 

Рис. 3.20 

 

Рис. 3.21 
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В открывшемся окне (рис. 3.22) – OK. 
 

 

Рис. 3.22 

Далее функциональной клавишей F2 выделяем все карты и объе-
диняем их: Map>Overlay Maps (рис. 3.23). 
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Рис. 3.23 

Подпишем начало и конец линии профиля буквами A и В соот-
ветственно. Для этого оцифруем концы линии профиля: выделяем кар-
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ту и аходим в меню Map>Digitize. Щелкаем мышкой по началу линии. 
В ткрывшемся окне digit.bln после чисел (т. е. координат оцифрован-
ной точки) ставим запятую, затем делаем пробел и пишем букву А. 
Нажимаем клавишу Enter. Также поступаем с концом линии разреза – 
после координат конца линии ставим запятую, затем делаем пробел, 
пишем букву В и нажимаем Enter (рис. 3.24). 

 

 

Рис. 3.24 

В окне digit.bln сохраняем файл как А-В.dat (рис. 3.25), закрыва-
ем окно А-В.dat и отменяем режим оцифровки. 
 

 

Рис. 3.25 

Далее последовательно выполняем действия: Map>Post 

Map>New Post Map открываем А-В.dat и опять объединяем все карты. 
Выбираем в Object Manager последнюю карту Post Map, двойным 

щелчком открываем окно ее свойств (рис. 3.26) и в закладке Lables 



 52 

в поле Worksheet Column for Lables выбираем колонку C. Нажимаем 
кнопку Font и в разделе Style ставим «галочку» в поле Bold (жирный 
шрифт) (рис. 3.27) >OK. 

 

 

Рис. 3.26 

 

Рис. 3.27 

В закладке General выбираем соответствующий символ (рис. 3.28) 
>OK. Карта с подписанным разрезом представлена на рис. 3.29. 
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Рис. 3.28 

-1000 -500 0 500 1000 1500 2000 2500 3000 3500 4000

-1000

-500

0

500

1000

1500

2000

2500

3000

3500

4000

4500

-2800

-2700

-2600

-2700

-2800

-2750

-2650

-2650

-2750

-2750
-2650

-2650

-2750

1

2

3

4

5

6

7

8

9

10
11

12

13

А

В

 

Рис. 3.29 
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Далее Grid>Slice, в окне Open Grid открываем файл кровля.grd, 

в окне Открыть открываем файл digit.bln, в окне Grid Slice (рис. 3.30) 
даем имя кровля.dat выходному файлу Output DAT File и делаем ак-
тивными опции Set values outside и Set values in blanked grids to. 

 

 

Рис. 3.30 

Откроем файл кровля.dat (рис. 3.31). 
 

 

Рис. 3.31 
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Структура данного файла была описана в начале этой главы. Чтобы 
построить разрез необходимо преобразовать этот файл с расширением *.dat 
в файл с расширением *.bln. Для этого необходимо столбцы А и В удалить, 
в первый столбец скопировать накопленное горизонтальное расстояние от 
начала профиля вдоль линии профиля (столбец D), а во второй – значение 
абсолютной отметки Z в точке пересечения линии профиля с грид-линией 
карты (столбец С). Для этого выделяем столбец D, щелкнув левой кнопкой 
мыши по букве D (рис. 3.32), затем щелкаем правой кнопкой мыши и в вы-
падающем меню выбираем Copy (Копировать). Затем выделяем столбец А 
и в выпадающем меню выбираем Paste (Вставить). Аналогично копируем 
столбец С в столбец В. Выделяем столбцы C и D в выпадающем меню вы-
бираем Delete (Уничтожить) (рис. 3.33). 
 

 

Рис. 3.32 

 

Рис. 3.33 
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Затем необходимо вставить новую строку перед первой строкой, 
для чего выделить первую строку, щелкнув мышкой по номеру строки 1 
и в выпадающем меню выбираем пункт Insert (Вставка) (рис. 3.34). Те-
перь в первой ячейке необходимо указать количество данных, во второй 
написать цифру 1 (рис. 3.35). Далее в меню File > Save as cохраняем 
файл как кровля.bln (рис. 3.36). 

 

 

Рис. 3.34 

 

Рис. 3.35 
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Рис. 3.36 

Загружаем разрез по кровле пласта: Map>Base Map, в открывшем-
ся окне Import File открыть файл кровля.bln, в окне (рис. 3.37) > OK. 
 

 

Рис. 3.37 

В Object Manager выбираем подобъект Base и редактируем его, 
открыв окно свойств данного подобъекта дойным щелчком левой 
кнопки мыши. В закладке Scale убираем «галочку» в Proportional XY 

scaling и в разделе Y Scale выставляем длину оси по координате Y 
(Length) приблизительно в два раза меньше длины оси по координа-
те Х (рис. 3.38). 
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Рис. 3.38 

После нажатия кнопки OK получаем разрез по кровле пласта 
(рис. 3.39). 
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Рис. 3.39 

Далее нам необходимо построить разрез по подошве пласта. 
Сначала рассчитываем ГРИД по подошве, не забывая, что область 
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его построения должна быть точно такой же, что и у файла 
кровля.grd (рис. 3.5), называем его подошва.grd и последовательно 
выполняем действия: Grid>Slice, в окне Open Grid открываем файл 
подошва.grd, в окне Открыть открываем файл digit.bln с координа-
тами линии разреза, в окне Grid Slice (рис. 3.30) даем имя 
подошва.dat выходному файлу Output DAT File и делаем активны-
ми опции Set values outside и Set values in blanked grids. Далее пре-
образовываем файл подошва.dat, аналогично файлу кровля.dat 
в айл подошва.bln для построения разреза по подошве пласта. Нане-
сем на Base Map подошвы линию водонефтяного контакта. 

Для этого выделяем подобъект Left Axis в Object Manager и от-
крываем окно его свойств: Map: Left Axis Properties, заходим на за-
кладку Scaling. В поле Major Interval ставим цифру 10 (рис. 3.40). 
 

 

Рис. 3.40 

Находим на оси ординат абсолютную отметку –2730 и, выделив 
подобъект Base, оцифровываем ее: Map>Digitize. В открывшемся окне 
digit.bln в меню File>Save as сохраняем файл как ВНК-2730.bln. За-
крываем окно ВНК-2730.bln, отменяем режим оцифровки. Строим ли-
нию ВНК: в меню Map> Base Map. В открывшемся окне Import File 

открываем файл ВНК-2730.bln. Выбираем в Object Manager только что 
построенный подобъект Base и открываем окно его свойств (рис. 3.41). 
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Рис. 3.41 

Находясь на закладке Base Map, нажимаем кнопку Line и выби-
раем стиль, цвет и толщину линии (рис. 3.42). 
 

 

Рис. 3.42 

Затем объединяем разрез по кровле, по подошве и водонефтяной 
контакт в один «Overlay»: Map>Overlay Maps (рис. 3.43). 
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Рис. 3.43 

В пакете Surfer есть возможность раскрасить рисунок над уров-
нем ВНК одну область коричневым цветом (нефть), под уровнем ВНК – 
две области голубым цветом (вода). Для этого необходимо аккуратно 
оцифровать соответствующие области так, чтобы они были замкнуты-
ми. Оцифровав область «нефть» сохраним файл (File>Save as) под име-
нем нефть.bln, закроем окно, отменим режим оцифровки. Открыв окно 
свойств данного файла (рис. 3.44) и заходя на закладку Base Map на-
жмем кнопку Fill (Заливка) (рис. 3.44). 

 

 

Рис. 3.44 
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В открывшемся окне Fill Properties выбираем цвет заливки 
(рис. 3.45) > OK > OK (рис. 3.46). 

 

 

Рис. 3.45 
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Рис. 3.46 

Аналогично оцифровав области, где «находится» вода, получаем 
два файла вода1.bln и вода2.bln, строим две карты Base Map, в свойст-
вах заливки выбираем синий цвет и объединяем все карты (рис. 3.47). 
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Рис. 3.47 

В Object Manager убираем Bottom Axis (Нижняя ось) и Right 

Axis (Правая ось), снимая «галочки» щелчком левой кнопки мыши 
(рис. 3.48). 

 

 

Рис. 3.48 
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В этой главе мы научимся: 
 загружать в Surfer растровое изображение; 

 масштабировать его; 

 проводит его оцифровку; 

 строить карты с тектоническими нарушениями. 

4.1. Загрузка и масштабирование растровых изображений 

Воспользуемся учебником «Нефтепромысловая геология и разра-
ботка нефтяных и газовых месторождений» М.А. Искандерова [3] для 
тестирования возможностей программы. Для этой цели мы отсканиро-
вали приведенный в учебнике рисунок структурной карты, осложнен-
ной тектоническим нарушением (рис. 4.1). 

 

 

Рис. 4.1 
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В программе Surfer имеется возможность загрузки растровых 
рисунков и присвоения углам растрового рисунка координат карты, 
что позволяет корректно масштабировать растровый рисунок и при 
необходимости объединять с картой и другими цифровыми данными 
в единый «Overlay». 

Используя иконку  для загрузки Base Map, или меню 
Map>Base Map загружаем сканированный файл в окно Plot1 (рис. 4.2). 

 
 

 

Рис. 4.2 

Выбрав в Object Manager подобъект Base и щелкнув по нему 
правой кнопкой мыши, в выпадающем меню выбираем пункт Properties 

(Свойства). В окне Map: Base Properties щелкнем левой кнопкой мы-
ши по закладке Base Map и зададим координаты растрового рисунка: 
Image Coordinates (рис. 4.3).  

Поскольку мы не знаем фактических координат карты, задаем 
свои условные координаты. 
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Левый нижний угол xMin– 0 м, yMin – 0 м, верхний правый угол 
xMax – 11000 м, yMax – 9000 м. Согласно этим координатам размеры 
планшета, на котором нарисована карта, составляют по координате X – 
11 км, а по координате Y – 9 км. 

 

 

Рис. 4.3 

 

 

Рис. 4.4 

Следует обратить внимание на то, что если бы сканированная 
картинка была загружена через меню File>Open, то присвоить ей какие-
либо координаты было бы невозможно. 

После того, как координаты присвоены, можно задать масштаб. 
Для этого уже известным способом во окне Map: Base Properties 
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(Свойства) выберем закладку Scale (Масштаб) и зададим по X и по Y 
значение 1000 (рис. 4.4). 

Таким образом, масштаб нашей карты 1:100 000, другими слова-
ми, каждый сантиметр на карте – это 1 километр на местности. 

4.2. Оцифровка скважин 

Наша задача попытаться построить учебную карту средствами 
программы Surfer, но для этого нужно, как минимум, иметь таблицу 
с координатами скважин и значениями абсолютных отметок структур-
ной поверхности в этих скважинах. Имея рисунок карты, эту задачу 
можно было бы решить с помощью линейки и ручки, но мы попытаемся 
выполнить ее, используя сканированную копию рисунка и программу 
Surfer. Первую половину задачи мы уже решили, задав загруженному 
рисунку карты угловые координаты. Вторую половину задачи – оциф-
ровка скважин – решаем с помощью команды Digitize в меню Map. Для 
этого убедимся, что в Object Manager выделен объект Base, и выбира-
ем в меню Map>Digitize. Курсор мыши принимает форму перекрестья. 
Наведя курсор на точку скважины № 1 щелкаем левой кнопкой мыши – 
появляется окно редактора (с именем digit.bln), в котором записаны ко-
ординаты скважины № 1 (рис. 4.5). 

 

 

Рис. 4.5 
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Щелкнув мышкой в окне редактора после второй координаты Y 
поставим запятую, пробел и подпишем значение абсолютной отметки 
пласта в скважине № 1 –1125. После значения абсолютной отметки по-
ставим еще одну запятую и через пробел запишем номер скважины –№ 1. 
Завершим операцию записи абсолютной отметки пласта нажатием кла-
виши Enter и повторим вышеописанную процедуру со скважиной № 2. 
Аналогично проведем оцифровку всех имеющихся скважин и сохраним 
содержимое окна редактора (File >Save As) в файле с расширением 
*.dat. Обратите внимание на то, что меню File>Save As следует выбрать 
в окне digit.bln редактора, а не окна Plot – программы Surfer. Закрыва-
ем окно и снимаем режим оцифровки (отменяем «галочку» в меню 
Map>Digitize). 

Для просмотра в окне таблицы Worksheet файл следует открыть 
через меню в окне Plot – File>Open. 

 

 

Рис. 4.6 
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Полученный табличный файл будет выглядеть так, как показано 
на рис. 4.6. В окне WorkSheet можно добавить новую строку 1 
и подписать в ней наименование каждого столбца. Как уже было сказа-
но выше, названия столбцов лучше писать английскими буквами. (X, Y, 
abs_otm, N-Skv). Для вставки пустой строки можно щелкнуть правой 
кнопкой мыши по имени строки 1. Строка будет выделена черным цве-
том и на экране появиться выпадающее меню. В меню следует выбрать 
пункт Insert (Вставить). Если выделена любая ячейка в строке 1 можно 
то же самое сделать, используя меню Edit>Insert и выбрав Entire Row. 

Убедившись в том, что все абсолютные отметки для скважин на-
писаны без ошибок, добавим его к сканированному рисунку в окне Plot, 

как карту Post (Точечные данные). Для наглядности точки скважин ви-
зуализированы в виде крестиков. (рис. 4.7). 

 

 

Рис. 4.7 

Зададим в качестве подписей точек номера скважин. По умолча-
нию эти подписи будут располагаться над скважинами. Поменяем цвет 
символа и цвет надписи над ним. Для этого в Object Manager выбираем 
подобъект Post и открываем окно его свойств. (рис. 4.8). 
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Рис. 4.8 

На закладке General меняем цвет символа, щелкнув по кнопке 
Default Symbol (рис. 4.9). 

 

 

Рис. 4.9 

Для того, чтобы вывести на карту значения абсолютных отметок 
необходимо создать еще одну карту Post и выбрать в качестве подписей 
значения абсолютных отметок из третьего столбца таблицы с оцифро-
ванными скважинами (рис. 4.6). Для наглядности расположим значения 



 71 

абсолютных отметок справа от символа и поменяем их цвет, как обычно, 
открыв окно свойств последней карты Post. Заходим на закладку Labels 

и в разделе Position Relative to Symbol выбираем Right (рис. 4.10). 
 

 

Рис. 4.10 

Нажав кнопку Font, поменяем цвет (рис. 4.11). 
 

 

Рис. 4.11 

Выделим все объекты в окне Plot, для чего нажмем функциональ-
ную кнопку F2 и объединим их с картой в единый «Overlay»: Map 

>Overlay Map (рис. 4.12). 
Внимательно сравнив полученные подписи с теми, что имеются 

на растре, убедимся в отсутствии ошибок в номерах скважин и значени-
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ях абсолютных отметок. В случае обнаружения ошибок необходимо 
внести исправления в исходный файл с оцифрованными данными. 

 

 

Рис. 4.12 

4.3. Построение карты по оцифрованным точкам 

Выбрав в качестве алгоритма построения сеточного файла метод 
Kriging, Вы можете построить карту по значениям в скважинах и вывес-
ти ее на экран, задав для наглядности изолиниям красный цвет, как по-
казано на рис. 4.13. Для этого в окне свойств подобъекта Contours 

(рис. 1.24) нажмем кнопку Line и в открывшемся окне выберем соответ-
ствующий цвет (Color). 

Внимательное сравнение карт показывает, что мы не получили 
ожидаемого результата, поскольку карты существенно отличается друг 
от друга. Следует отметить, что добиться полного сходства при по-
строении карт по данным в скважинах в ручном варианте и с использо-
ванием компьютерных программ практически невозможно. Человек при 
построении такой карты на участках, где возможны различные вариан-
ты проведения изогипс, использует определенные допущения, в то вре-
мя как программа строго следует запрограммированному в ней алго-
ритму. При этом доказать правильность проведения изогипсы без 
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наличия дополнительных данных невозможно. Именно поэтому изогип-
сы в машинной карте более извилисты, а в карте, приведенной в учеб-
нике, их как будто проводили по лекалу. 

 

 

Рис. 4.13 

Обратим внимание на то что, наиболее существенное отличие 
проявляется в зоне тектонического нарушения, которое на карте отме-
чается только увеличением частоты изогипс между скважинами на уча-
стке, соответствующем нарушению. В программе Surfer существуют 
возможности построения карт с учетом разломов. 

4.4. Построение структурной карты с разломом 

Попытаемся учесть нарушение при построении карты. Зададим 
линию разлома в виде файла формата [.BLN]. Для этого воспользуемся 
уже известной процедурой оцифровки Map>Digitize. Для оцифровки 
достаточно двух краевых точек линии нарушения. Для этого щелкнем 
сначала по одному краю нарушения, затем по другому и сохраним файл 
с расширением *.bln (предлагается по умолчанию). Для проверки загру-
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зим оцифрованный файл нарушения (Map>Base Map) и включим его 
в существующий «Overlay». 

Если при этом положение нарушения совпало с нарисованным, 
можно приступать к построению карты с учетом нарушения (рис. 4.14). 

 

 

Рис. 4.14 

В программе Surfer для задания линейных границ при построении карт 
существуют два понятия: Faults – разломы и Breaklines – линии перегиба. 
В случае использования Faults линия служит как барьер при построении кар-
ты. Точки, расположенные по разным сторонам от этой границы интерполи-
руются порознь. Другими словами, при интерполяции используются только 
точки, расположенные по одну сторону относительно линии нарушения. По-
этому в файле *.bln задаются только координаты узлов линии разлома. 

В файле *.bln при задании линий перегиба Breaklines дополнитель-
но в третьем столбце указывается координата Z каждого узла линии. 

Следующие Gridding (гриддинг) методы поддерживают построе-
ние (расчет равномерных сеток c учетом разломов Faults): 

 Inverse Distance to a Power; 
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 Minimum Curvature; 

 Nearest Neighbor; 

 Data Metrics. 
Построение Breaklines – линий перегиба поддерживают большее 

количество Gridding методов: 
 Inverse Distance to a Power; 

 Kriging; 

 Minimum Curvature; 

 Nearest Neighbor; 

 Radial Basis Function; 

 Moving Average; 

 Data Metrics; 

 Local Polynomial. 

 
В нашем случае используем Faults (Разломы). Как видно в спи-

ске алгоритмов, поддерживающих тектонические нарушения Faults от-
сутствует метод Kriging по причине сложности (неоднозначности) воз-
никающих при решении систем уравнений. Поэтому воспользуемся 
методом Minimum Curvature (Минимальная кривизна). 

Используя меню Grid>Data, откроем в диалоговом окне файл с 
данными. В окне Grid Data в качестве Gridding метода выберем Mini-

mum Curvature и щелкнем по кнопке Advanced Option (рис. 4.15). 
 

 

Рис. 4.15 
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Выберем закладку Breaklines and Faults (рис. 4.16) и в поле File 

Containing Fault Traces, щелкнув по иконке , введем файл с оциф-
рованным разломом (рис. 4.16). Вернувшись в окно Grid Data, щелкнем 
по кнопке ОК. 

 

 

Рис. 4.16 

Результат сопоставления полученной карты с эталонной приведен 
на рис. 4.17. 

Карта построена с учетом тектонического нарушения и принци-
пиально правильно отражает данные имеющихся скважин, но заметно 
отличается от карты, приведенной в учебнике. Цель этого примера не 
только в том, чтобы уметь строить карты с учетом нарушений, но и для 
того, чтобы критически относиться к полученным результатам. Имея 
только значения абсолютных отметок в редких скважинах, мы не знаем 
положения структуры в точках, где скважины отсутствуют и, следова-
тельно, в этих частях карты ошибки могут быть существенными. 

Для уменьшения неоднозначности при оценке положения струк-
туры в межскважинном пространстве геологами используются данные 
сейсморазведочных работ, использование которых не только сущест-
венно уточняет структурный план, но и в отличие от построения карт по 
отдельным точкам позволяет более полно использовать возможности 
компьютеризированного построения карт. Более того, при построении 
карт по данным 3D сейсморазведки ручное построение уже непримени-
мо из-за гигантского количества интерполяционных точек. Так, напри-
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мер, на участке площадью 11 км на 9 км (как в нашем примере) нам 
пришлось бы провести интерполяцию между 159201 точкой. 

 

 

Рис. 4.17 

На рис. 4.18 приведена построенная с учетом тектонического на-
рушения карта с использованием значений абсолютных отметок не 
только в скважинах, но и значений в дополнительных точках в виде 
оцифрованных изолиний. Оцифрованные точки, соответствующие изо-
линиям карты визуализированы в виде карты классифицированных то-
чек – Classed Post и показаны разными условными обозначениями. При 
выполнении команды Classed Post на дисплее выводится диалоговое 
окно Map: Classed Post Properties (рис. 4.19). Функциональные группы 
этого окна аналогичны окну Post Map. Основное отличие заключается в 
добавлении к координатам X и Y значения Z (Value), т. е. в Classed Post 
необходимо указать еще одну переменную, по которой необходимо 
классифицировать точки. Область значений переменной разбивается на 
заданное число классов с символьным изображением каждого класса. 
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Рис. 4.18 

 

Рис. 4.19 
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Построенная карта достаточно точно соответствует исходной 
растровой карте. Следует обратить внимание на то, что несмотря на 
относительно большое количество оцифрованных точек, в северо-
западной и юго-восточной частях карты отмечаются отклонения, вы-
званные особенностями использованного данного алгоритма. Хотя 
рассмотренный пример не является оптимальным, тестирование по-
зволяет оценить алгоритм, используемый при расчете равномерного 
ГРИДА и правильно интерпретировать полученные результаты. Не-
оптимальность используемой исходной карты (растра), по нашему 
мнению, обусловлена тем, что она сама является искусственным при-
мером подземной поверхности. 
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В программе Surfer имеется возможность при выводе скрывать 
часть ячеек ГРИДА (Grid). Для этой цели предусмотрено специальное 
значение (Blanking value), равное 1.70141е+38, которое присваивается 
тем ячейкам ГРИДА, которые необходимо скрыть. Surfer не учитывает 
эти значения при математических операциях с ГРИДАМИ (в том числе 
при вычислениях объема и площади) и при их визуализации. Программа 
«считает», что в данной ячейке значение отсутствует. Для простоты 
процедуру присвоения ячейкам ГРИДА значений 1.70141е+038 (Blank-

ing value) будем называть «бланкированием». 
Подобная процедура может понадобиться для удаления (скрытия) 

тех частей ГРИДА (карты), которые были рассчитаны либо в области от-
сутствия скважин, либо с целью выделения определенного участка карты. 

Поскольку ячейки ГРИДА (карты) в процессе бланкирования не 
удаляются, то соответственно размерность карты (количество ячеек по 
оси Х и Y) остается без изменений. 

В программе Surfer существует несколько способов присвоения 
ячейкам карты бланкированных (Blank) значений. Наиболее часто эта 
задача решается с использованием меню Grid>Blank. 

Для задания области ГРИДА, в которой ячейкам будет присваи-
ваться значение «отсутствия данных», существует специальный файл 
формата [.BLN] (blanking file). Это обыкновенный текстовый файл 
формата ASCII, который можно создавать как в таблице WorkSheet, так 
и в обычном текстовом редакторе. Файл состоит из двух столбцов. 
В первой строке первого столбца этого файла указывается количество 
узлов, из которых состоит полигон (область бланкирования). Во втором 
столбце первой строки записывается значение 0 или 1 («флаг»). В слу-
чае, когда в качестве «флага» использован 0 бланкируются значения 
ГРИДА, расположенные вне полигона в противном случае значения 

Blank присваиваются ячейкам, лежащим внутри полигона. В после-
дующих строчках указываются координаты узлов полигона. Их количе-
ство должно соответствовать значению, указанному в первой ячейке 
таблицы. Полигон для бланкирования должен быть обязательно замк-
нут, т. е. координата последнего узла должна совпадать с координатой 
первого. Файл *.bln автоматически создается при выполнении меню 
Map>Digitize. Следует помнить, что по умолчанию при генерации фай-
ла *.bln в качестве «флага» заносится значение 1. 

Для создания ГРИДА воспользуемся меню Grid>Function 

(рис. 5.1). 
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Рис. 5.1 

Сетку рассчитаем равномерную с шагом (Increment) 10 × 10. Раз-
меры области построения по X и по Y (от –1000 до +1000). Значения Z 
зададим в виде аналитической функции: 

Z=(x2+y2)*(–1). 

Функция возведения в степень в программе Surfer – pow(x, y), где 
вместо х подставляется число, которое необходимо возвести в степень 
y. Соответственно 52 будет выглядеть, как pow(5,2). 

В нашем случае значения координаты X и Y возводятся в квадрат 
и суммируются. Полученную функцию для наглядности умножаем на 
минус единицу. 

z=(pow(x,2)+pow(y,2))*(–1)). 

Результирующий ГРИД сохраним в файл с именем polusfera.grd. 
Для сравнения можно самостоятельно рассчитать и визуализиро-

вать ГРИД в виде трехмерной поверхности (3D Surface) без умножения 
на минус единицу. 

Используя меню File>New >WorkSheet, создаем новую пустую 
таблицу. Заносим в нее значения координат полигона (рис. 5.2). 

Используя в WorkSheet меню File>Save As набираем в качестве 
имени файла BlankPoligon, а в качестве типа файла Golden Software 

blanking (*.bln) (рис. 5.3). 
В новом окне Plot визуализируем ГРИД в виде карты в изолиниях. 

Map>Contour Map > polusfera.grd. 
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Рис. 5.2 

 

Рис. 5.3 

Затем визуализируем файл *.bln: Map>Base > Map> BlankPoli-

gon.bln и создадим единый «Overlay» из полученных карт (рис. 5.4). 
Для наглядности полигон выделен красным цветом. 

Теперь выполним бланкирование рассчитанного ГРИДА: 
Grid>Blank. В качестве ГРИДА выбираем polusfera.grd, в качестве 
полигона для бланкирования – файл BlankPoligon.bln и сохраняем 
результат в файл polusferaBLN.grd. Визуализацию полученного фай-
ла проводим в новом окне Plot в виде трехмерной поверхности 
(3D Surface) (рис. 5.5). 
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Рис. 5.4 

 

Рис. 5.5 

Открыв окно свойств поверхности (рис. 5.6), ставим «галочку» 
в поле Show Base (Показать основание) и выбираем его цвет, напри-
мер, желтый > OK. 



 84 

 

Рис. 5.6 

В результате получим поверхность, представленную на рис. 5.7. 
 

 

Рис. 5.7 
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Кроме построения карт и разрезов, в Surfer имеется возможность 
вычисления объемов. Найдем, например, объем, ограниченный поверх-
ностью, у которой значения Z заданы в виде аналитической функции 
Z=(x2+y2) и плоскостью Z=0. Рассчитаем ГРИД: Grid>Function и дадим 
ему имя по умолчанию out.grd (рис. 6.1)>OK. 

 

 

Рис. 6.1 

Затем в меню Grid выбираем Volume, в открывшемся окне Open 

Grid выбираем out.grd >Открыть (рис. 6.2). 
 

 

Рис. 6.2 
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В открывшемся окне Grid Volume в верхней строке Upper Sur-

face (Верхняя поверхность) выбран файл out.grd, в нижней строке 
Lower Surface (Нижняя поверхность) по умолчанию плоскость Z=0 
(рис. 6.3) >OK. 
 

 

Рис. 6.3 

Программа выдаст сообщение о вычисленном тремя численными 
методами объеме в виде отчета (рис. 6.4). Находя среднее арифметиче-
ское, получим ответ. 
 

 

Рис. 6.4 
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В нефтегазовой геологии подсчет запасов углеводородов по зале-
жи проводится по формуле: 

**** КнmVэфнQ V , 

где Vэфн  – объем эффективных нефтенасыщенных толщин; 

m – коэффициент открытой пористости; 
Kн – коэффициент нефтенасыщенности; 
θ – пересчетный коэффициент, учитывающий присутствие в неф-
ти растворенного газа; 
ρ – плотность нефти. 
Зная подсчетные параметры, задачу подсчета запасов можно 

представить как расчет объема Vэфн . Например, дана таблица исходных 

данных (таблица). Чтобы иметь возможность производить некоторые 
вычисления, перенесем ее в Microsoft Excel, помня, что в первых двух 
столбцах Surfer по умолчанию «читает» значения координат скважин. 
Поэтому лучше столбец с номерами скважин сделать последним. Тип 
файла при сохранении выбираем: Книга Microsoft Excel 5.0/95. 

 
Таблица 

№ 

скв 
X, м Y, м 

Абсолютная 
отметка  

подошвы 
пласта h, м 

Абсолютная 
отметка 
кровли  

пласта H, м 

Эффективная 
толщина h эф, 

м 

Коэффициент 
открытой 

пористости 

Коэффициент 
нефтенасы-
щенности 

1р 1000 8000 –2079.2 –2061.5 16.8 0.177 0.637 

2 1500 6500 –2173.3 –2160 12.8 0.198 0.798 

3 3500 10000 –2264.8 –2247.5 15.6 0.199 0.717 

4 3500 7500 –2160.7 –2151.9 8.2 0.201 0.606 

5 3500 5500 –2247.7 –2237.4 10.1 0.167 0.658 

6 1800 2500 –2250.9 –2232.8 16.8 0.187 0.582 

7 6000 9000 –2266.8 –2255.8 9.6 0.184 0.714 

8р 4500 7500 –2067.6 –2058.2 9.0 0.192 0.67 

9 5500 6500 –2270.8 –2255.7 12.3 0.184 0.728 

10 6500 4000 –2239.1 –2223.8 13.8 0.175 0.668 

11 8500 11500 –2272.5 –2258 12.8 0.185 0.511 

12р 8000 8500 –2080.8 –2066.3 11.6 0.187 0.73 

13 8500 7000 –2186.2 –2176 9.8 0.176 0.814 

14 7500 6500 –2214.1 –2204.9 9.0 0.189 0.684 

15 7500 6000 –2236.3 –2225 11.1 0.167 0.821 

16р 12000 9500 –2065.9 –2054.3 11.2 0.169 0.7 

17 10500 5000 –2256.8 –2247 9.6 0.16 0.78 

18 9500 2000 –2265.4 –2250.4 14.2 0.171 0.827 

19 13000 7500 –2241.8 –2228.8 12.4 0.159 0.55 

20 12000 4500 –2203.1 –2188.9 13.2 0.16 0.591 
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Абсолютная отметка водонефтяного контакта равна –2191.5 м, 

=0.81, =840 кг/м3. 
Следует отметить, что координаты скважин необходимо задавать 

в метрах. Если координаты скважин «снимаются» непосредственно 
с рисунка карты с помощью линейки в сантиметрах, то следует, исполь-
зуя масштаб карты, перевести их в метры. 

Нам необходимо найти объем эффективных нефтенасыщенных тол-
щин. Поэтому сначала в Excel находим общие толщины вычитанием абсо-
лютной отметки подошвы из абсолютной отметки кровли для первой сква-
жины. В правом нижнем углу рамки текущей ячейки имеется черный 
квадратик – маркер автозаполнения [4]. При наведении на него указатель 
мыши (он обычно имеет вид толстого белого креста) приобретает форму 
тонкого черного крестика. Перетаскивание маркера заполнения рассматри-
вается как операция «размножения» содержимого ячейки в горизонтальном 
или вертикальном направлении. Воспользовавшись маркером автозаполне-
ния, «протягиваем» формулу для нахождения общих толщин по всем сква-
жинам, не отпуская при этом левую кнопку мыши. Затем находим распре-
деление по площади коэффициента песчанистости, как отношение 
эффективных толщин к общим толщинам. Чтобы найти нефтенасыщенные 
толщины, необходимо найти «новые» абсолютные отметки кровли и по-
дошвы пласта так, чтобы уровень водонефтяного контакта совпал с плоско-
стью Z=0, при этом абсолютные отметки подошвы и кровли примут поло-
жительные значения. Для этого надо вычислить, например, в столбцах L и 
M листа Excel функцию МАКС(D2-$N$2;0) и МАКС(C2-$N$2;0), где D2 
и C2 – адреса ячеек, содержащих значения абсолютных отметок кровли и 
подошвы пласта соответственно для первой скважины, N2 – адрес ячейки, 
содержащей значение абсолютной отметки водонефтяного контакта. Про-
тянув формулу для всех скважин с помощью маркера автозаполнения, по-
лучим данные для нахождения нефтенасыщенных толщин [5]. Рассчиты-
ваем ГРИДЫ для найденных абсолютных отметок кровли (кровля.grd) 
и подошвы (подошва.grd), а также ГРИД для коэффициента песчанисто-
сти Кпесч.grd. При нахождении объемов не следует расширять область 
построения сеточного файла. Умножаем файл кровля.grd на файл 
Кпесч.grd, воспользовавшись меню Grid>Math, даем имя выходному 
файлу кровляКпесч.grd. Также умножаем файл подошва.grd на 
Кпесч.grd, даем имя выходному файлу подошваКпесч.grd. Чтобы найти 
объем эффективных нефтенасыщенных толщин, в меню Grid выбираем 
Volume. В окне Open Grid выбираем файл кровляКпесч.grd >Открыть. 
В открывшемся окне Grid Volume (рис. 6.5) в верхней строке уже выбран 
файл кровляКпесч.grd, в нижней строке переключатель устанавливаем 
в Grid File и выбираем файл подошваКпесч.grd>OK (рис. 6.6). 
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Рис. 6.5 

 

Рис. 6.6 

Объем эффективных нефтенасыщенных толщин для данного ва-
рианта исходных данных Vэфн =404590644,88 м3. 

Можно посчитать объем другим способом. Вычтем из файла 
кровля.grd файл подошва.grd, тем самым мы находим ГРИД общих 
нефтенасыщенных толщин. Найденный ГРИД умножаем на файл 
Кпесч.grd и находим объем по последнему ГРИДУ. Предлагаем само-
стоятельно убедиться в том, что ответ будет таким же. 

Далее находим Q, умножая в Excel Vэфн на коэффициент откры-
той пористости, коэффициент нефтенасыщенности, используя маркер 
автозаполнения, затем на пересчетный коэффициент и плотность. 
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1. Из Microsoft Word в Microsoft Excel перенести таблицу исход-
ных данных своего варианта. 

2. В Surfer построить карту скважин, подписать скважины и выне-
сти на карту абсолютные отметки. 

3. Построить структурную карту по кровле пласта в изолиниях 
и объединить ее с картой скважин, которые должны быть внут-
ри структурной карты, нанести на карту линию водонефтяного 
контакта. 

4. Визуализировать поверхности кровли и подошвы в трехмерном 
виде (3D Surface), объединить с плоскостью водонефтяного кон-
такта и картой скважин. 

5. Построить профильный разрез по кровле и по подошве с линией во-
донефтяного контакта по четырем скважинам, нанести на структур-
ную карту линию разреза и подписать ее. 

6. Найти объем эффективных нефтенасыщенных толщин и запасы 
углеводородов по залежи. 

7. В Microsoft Word написать отчет. 
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